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Project 2: African Wildlife Poster

Stage 2  Compositing with Smart Objects

Your client provided a number of animal pictures that you can use in the � nished artwork. In Project 

1, you learned the two basic methods for compositing � les into another � le — copy and paste (or 

drag) and placing a � le as a Smart Object. Your ultimate goal determines which of these methods is 

most appropriate for a speci� c job.

Smart Objects are layers that preserve source content, which means you can apply 

non-destructive transformations to the layer. (Non-destructive means you do not alter 

the actual image data; you can restore the original image content, or make changes to 

the transformations that you apply, without negatively a� ecting the image quality.)

Smart Objects also allow you to apply non-destructive image � lters. When you 

apply a Photoshop � lter to a regular layer, the pixels on the layer are permanently 

a� ected (unless you undo the � lter or step back through the History panel). Using 

Smart Objects means you can apply non-destructive � lters to a layer since you aren’t 

a� ecting the actual � le data.

COMPARE SMART OBJECT LAYERS TO NORMAL LAYERS

In this exercise, you apply layer masks and � lters to the client’s animal pictures. 

However, you don’t want to modify the actual photo � les, and you want to be able to 

change the � lter settings if the client doesn’t like the initial results. To accomplish both 

of these objectives, you will place the animal images as Smart Objects.

 1. With africa_working.psd open, choose File>Place. 

 2. Navigate to addax.tif in the RF_Photoshop>
Africa folder, click Place, and 

then press Return/Enter to � nalize the placement in the document window.

 3. Repeat Step 2 to place lion.tif into your working � le.

 4. Choose File>Open. Select giraffe.jpg and gorilla.tif and click Open.

 5. Use the Arrange Documents panel in the Applications/Menu bar to show all 

three documents at once within the workspace.

We used the 

3 Up arrangement 

in the Arrange 

Documents panel.

In addition to placing 

� les as Smart Objects, 

you can also open a � le 

as a Smart Object in the 

File menu.

Note:

5project
Catalog Cover
Your client is a mail-order children’s 

clothing company that sends monthly 

catalogs to a large mailing list 

throughout the United States. July 

is their biggest sales months since 

parents are buying their children new 

clothes for the start of the school year. 

� e company hired your agency to 

create the new fall catalog, which will 

be mailed in mid-June. Your job is to 

build the catalog cover.

� is project incorporates the following skills:

� Using � lters and adjustments to identify edges in a complex image

� Creating a complex mask by adjusting an Alpha channel

� Painting directly on an Alpha channel

� Compositing a background image with special e� ects

� Adding layer e� ects to spot-color objects

� Building a spot channel for a special ink color

� Creating warped and spot-color type 
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Project Meeting
Here’s a basic synopsis of the movie:

Most American history books teach us that our 
“forefathers” were esteemed, venerable men who 
crafted the United States out of lofty and respected 
ideals. But there’s an old saying that history is 
written by the victors… In other words, who were 
these men really, and exactly how honorable were 
they? � e movie is about the events during and af-
ter the American Revolution — not the war itself, 
but the personal aspects that drove these individu-
als to do what they did. It’s not a war movie, and 
it’s not a political movie. It’s more a study of the 
human condition… How greed and power can 
corrupt even the most idealistic of men.

� is movie is going to be one of our sum-
mer blockbusters, and we’re throwing a lot of 
resources behind it. We’ll be putting the same 
ad in multiple magazines, and they all have 
slightly di� erent page sizes. We’ve forwarded 
the advertising specs for two of them to your 
art director, since those are the only ones we 
have right now.

� e client loved the initial concept sketch I 
submitted last week, so we’re ready to start 
building the � les. I’ve had the photographer 
prepare the images we need, and the client has 
provided the studio and rating logo � les. � ey 
also sent me the two magazines’ specs:

Magazine 1

–  Files should be submitted as native layout 
� les or layered TIFF; CMYK only

–  Bleed size: 8.75 × 11.25″

–  Trim size: 8.5 × 11″

–  Live area: 8 × 10.5″

Magazine 2

–  Files should be submitted as native layout 
� les or � attened TIFF; CMYK only

–  Bleed size: 8.25 × 10.25″

–  Trim size: 8 × 10″

–  Live area: 7.5 × 9.5″

To complete this project, you will:

� Create a single � le that can contain 
multiple page sizes

� Composite multiple images into a single 
background � le

� Incorporate both raster and vector elements 
into the same design

� Use selection techniques to isolate images 
from their backgrounds

� Transform and arrange individual layers to 
create a cohesive design

� Create layer groups and nested groups to 
easily manage � les

� Save two di� erent types of TIFF � les for 
di� erent ad requirements

203Project 3: Moonscapes Book Cover

CREATE EFFECTS WITH LAYER STYLES

All the design elements are starting to work together now, and your book cover is 
almost complete. If you look at the title, however, the black in the clipped image gets 
lost in the black background. Plus, the title and subtitle are rather stark, and they seem 
to � oat on the cover instead of functioning as an integrated part of the design. You’re 
going to use layer styles to solve those problems.

You worked with layer styles in Project 2, even if you didn’t realize it. In that 
project, you applied prede� ned styles and textures to the map shape layer using the 
Photoshop Style libraries. � ose styles are simply saved groups of layer style settings 
that you can apply with a single click. In this project, you’re going to learn how to 
apply and control the individual components that make up those prede� ned styles.

 1. In the open moonscapes.psd � le, expand the Title All and nested Main 
Title folders in the Layers panel.

 2. Select the Moonscapes type layer and choose Layer>Layer Style>Outer Glow.

When you open the Layer Style dialog box, the preview option is automatically checked. 
You can see the e� ects of your selections in the image behind the dialog box.

The soft outer glow is 
shown around the 
layer edges.

When the Preview check 
box is selected, you can 
immediately see the 
effects of your choices. 

Walk-Through

Visual Explanations
Wherever possible, screen shots 
are annotated so students 
can quickly identify important 
information.

Step-By-Step Exercises
Every stage of the workfl ow is 
broken into multiple hands-on, 
step-by-step exercises.

Real-World Workfl ow 
Projects are broken into logical lessons or 
“stages” of the workfl ow. Brief introductions at 
the beginning of each stage provide vital foun-
dational material required to complete the task.

Project Goals
Each project begins with a clear description 
of the overall concepts that are explained 
in the project; these goals closely match the 
different “stages” of the project workfl ow.

The Project Meeting
Each project includes the client’s initial 
comments, which provide valuable 
information about the job. The Project 
Art Director, a vital part of any design 
workfl ow, also provides fundamental 
advice and production requirements. 

Project Objectives
Each Project Meeting includes a 
summary of the specifi c skills required 
to complete the project.
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268 Project 4: Menu Image Correction

Project Summary
As with many other skills, it takes time and practice to master image correction techniques. 

Understanding the relationship between brightness and contrast, and how these two values a� ect 

the quality of reproduction in digital images, is the � rst and possibly most critical factor in creating 

a high-quality image. An image that has too much contrast (a “sharp” image) or not enough contrast 

(a “� at” image) translates to an unsatisfactory print. A basic understanding of color theory (speci� cally complementary color) is the foundation 

of accurate color correction. E� ective color correction relies on the numbers, rather than what you 

think you see on your monitor. As you gain experience in correcting images, you will be better able 

to predict the corrections required to achieve the best possible output. 
Remove photographic grain with blur and 
sharpen techniques

Use the Healing Brush and Spot Healing Brush tools to correct scratches

Use the Clone Stamp tool to remove major damage

Correct contrast and tonal range using the 
Levels adjustment

Correct lighting problems with the Exposure adjustment

Correct contrast with the Curves adjustment

Correct gray balance using the Curves adjustment

Correct overall color cast using the Color Balance adjustment

Correct minor color problems using the Brightness/Contrast adjustment

Correct and convert the image using the defined destination CMYK profile
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Project Review
1. The _______________ is the range of 

visible and available color in a particular 

color model. 

2. _______________ is likely to cause degradation 

of a raster image when it’s reproduced on a 

printing press.

3. A _______________ is a linked fi le that you 

placed into another Photoshop document.

4. The _______________ is context sensitive, 

providing access to different functions 

depending on what tool is active.

5. The _______________ is the fi nal size of a 

printed page.

6. The _______________ tool is used to draw 

irregular-shaped selection marquees.

7. The _______________ tool is used to create 

precise shapes based on anchor points and 

connecting line segments.

8. The _______________ tool can be used to drag 

layer contents to another position within the 

image, or into another open document.

9. When selecting color ranges, the 

_______________ value determines how much 

of the current color range falls into 

the selection. 

10. _______________ is a lossy compression 

method that is best used when large fi le size 

might be a problem.

1. Briefl y describe the difference between raster images and vector graphics. 

2. Briefl y explain three separate methods for isolating an image from its background.

3. Briefl y describe the relationship between anchor points and handles (direction lines) on a vector path.

138 Project 2: African Wildlife Poster
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The Distortion Filters

Original Image

Diffuse Glow adds a haze of 

the current background color to 

lighter regions of the image.

Displace distorts an image 

based on a displacement map 

(the tone values of which 

determine the distortion).

Glass simulates the effect of 

looking through different 

types of glass.

Ocean Ripple simulates an 

underwater effect by adding 

randomly spaced ripples.

Pinch creates the effect of 

squeezing the edges of the 

image toward the center. 

Polar Coordinates creates

the effect of wrapping the 

image into a cylinder. 

Ripple distorts the image. 

You can only define the 

amount and size of the effect.

Shear distorts the image 

as if it were being reflected 

on an angled mirror.

Spherize simulates the effect 

of wrapping an image around a 

three-dimensional sphere. 

Twirl simulates the

effect of placing the image 

into a whirlpool. 

Waves creates a rippled effect 

with control over wavelength, 

amplitude, and wave type.

ZigZag distorts pixels 

diagonally, out from the center, 

or around the center.

Filters can be used for a variety of purposes, from purely aesthetic to technically functional. 

You can apply fi lters to specifi c selections, individual layers, or even individual channels 

depending on             what you need to accomplish. If you combine fi lters with  Smart Objects, you 

can also apply nondestructive fi lters and then change the settings or turn off the fi lter to 

experiment with different results. 

The Distortion fi lters let you squeeze, stretch, bend, twist, and otherwise distort an image 

or selection. Some of these fi lters are controlled in the  Filter Gallery, while others have their 

own dialog boxes.
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Use what you learned in this project to complete the following freeform exercise. 
Carefully read the art director and client comments, then create your design to meet the needs of the project.
Use the space below to sketch ideas; when fi nished, write a brief explanation of the reasoning behind your design.

Portfolio Builder Project

Tantamount Studios is pleased with your work 
on the Forefathers ad, and they would like to 
hire you again to create the ad concept and � -
nal � les for another movie that they’re releasing 
early next year. 

To complete this project, you should:

�  Find appropriate background and 
foreground images for the movie theme (see 
the client’s comments at right).

�  Incorporate the title artwork, logos, and 
rating placeholder that the client provided.

�  Composite the di� erent elements into a 
single completed � le; save both a layered 
version and a � attened version.

 � e movie is titled Above and Beyond. Although the 
story is � ctionalized, it will focus on the men who 
led the � rst U.S. Airborne unit (the 501st), which 
su� ered more than 2000 casualities in the Euro-
pean theater of World War II.

We already have the title artwork, which we gave 
you in the RF_Builders>Airborne folder. 

 We don’t have any other images in mind, but the 
� nal ad should re� ect the time period (the 1940s) 
of the movie. � e 501st Airborne was trained to 
parachute into battle, so you should probably in-
corporate some kind of parachute image. 

 � is movie is another joint venture between Sun 
and Tantamount, so both logos need to be included 
in the new ad. It isn’t rated yet, so please use the 
“� is Movie Is Not Yet Rated” artwork (in the 
RF_Builders>Airborne folder) as a placeholder.

 Create this ad big enough to � t on an 8.5 × 11″ 
page, but keep the live area an inch inside the trim 
so the ad can be used in di� erent sized magazines.

Portfolio Builder Projects
Each step-by-step project is accompanied 
by a freeform project, allowing students to 
practice skills and creativity, resulting in an 
extensive and diverse portfolio of work.

Visual Summary
Using an annotated version of the 

finished project, students can quickly 
identify the skills used to complete 

different aspects of the job.

108 Project 2: African Wildlife Poster

 7. Open the Style panel Options menu again and choose Textures near the 
bottom of the list.

After Step 6, the 
panel appears in 
Large List view.

In either list view, the 
word in parentheses 
shows the collection of 
that style. 

The bottom part of the 
list includes 10 collections 
of predefined styles. 

 8. Click OK to replace the current set with the Textures set.

When you call a new set of styles, Photoshop asks if you want to replace the current set 
or append the new set to the existing set(s).

 9. If possible, expand the panel so you can see all the styles in the Textures set.

 10. Make sure the shape layer is selected in the Layers panel and then click 
Ancient Stone in the panel to apply the style to the shape layer.

The selected style fills 
the shape layer. 

The path is active 
in the image.

The Layers panel shows 
that a series of effects — 
the ones that make up 
the style — has been 
applied to the shape layer.

 11. Save the � le and continue to the next stage of the project.

� e same style options 
can also be accessed and 
applied in the Styles 
panel (Window>Styles).

Note:

� e actual vector path 
has to be active to change 
the � ll attributes. If you 
don’t see the path in the 
document window, click 
the path icon in the 
Layers panel to select it.

Note:

Photoshop Foundations
Additional functionality, related tools,  
and underlying graphic design concepts  
are included throughout the book.

Advice and Warnings
Where appropriate, sidebars  
provide shortcuts, warnings, or 
tips about the topic at hand.

Project Review
After completing each project, students  
can complete these fill-in-the-blank and 
short-answer questions to test their under-
standing of the concepts in the project.
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 3 Moonscapes Book Cover

o Setting up the 
Workspace 

o Working with Text 

o Editing Layers for 
Visual Impact

o Outputting Files
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 2 African Wildlife Map

o Setting Up the Workspace

o Compositing with 
Smart Objects

o Using Filters and 
Adjustments

o Creating an Artistic 
Background

o Creating Variations
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 1 Four-Color Movie Ad

o Setting Up the 
Workspace

o Compositing 
Images and 
Artwork

o Creating 
Silhouettes

o Managing 
Multiple Layers

o Saving Photoshop Files for Print

 Th e Portfolio Series is specifi cally designed to meet the 
unique needs of graphic arts educators. 

Th e Portfolio Series teaches graphic design software 
tools and techniques entirely within the framework of 
real-world projects; we introduce and explain skills where 
they would naturally fall into a real project workfl ow. 
For example, rather than off ering an entire chapter about 
printing (which most students fi nd boring), we teach 
printing where you naturally need to do so — when you 
complete a print-based project (Project 2).

Th e project-based approach in the Portfolio Series 
allows you to get in depth with the software beginning 
in Project 1 — you don’t have to read several chapters 
of introductory material before you can start creating 
fi nished artwork. 

Th e project-based approach of the Portfolio Series 
also prevents “topic tedium” — in other words, we don’t 
require you to read pages and pages of information about 
text (for example); instead, we explain text tools and 
options as part of a larger project (in this case, as part of a 
book cover). 

Clear, easy-to-read, step-by-step instructions walk 
you through every phase of each job, from creating a new 
fi le to saving the fi nished piece. Wherever logical, we also 
off er practical advice and tips about underlying concepts 
and graphic design practices that will benefi t students as 
they enter the job market.

Th e projects in this book refl ect a range of diff erent 
types of Photoshop jobs, from creating a magazine ad 
to correcting menu images to building a Web page. 
When you fi nish the eight projects in this book (and 
the accompanying Portfolio Builder exercises), you will 
have a substantial body of work that should impress any 
potential employer.

Th e eight Photoshop CS4 projects are described 
briefl y here; more detail is provided in the full table of 
contents (beginning on Page viii).

Projects at a Glance
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Some experts claim most people use only a small fraction — 
maybe 10% — of their software’s capabilities; this is likely 
because many people don’t know what is available. As you 
complete the projects in this book, our goal is to familiarize 
you with the entire tool set so you can be more productive and 
more marketable in your career as a graphic designer.

It is important to keep in mind that Photoshop is an 
extremely versatile and powerful application. The sheer 
volume of available tools, panels, and features can seem 
intimidating when you first look at the software interface. 
Most of these tools, however, are fairly simple to use with a 
bit of background information and a little practice. 

Wherever necessary, we explain the underlying concepts 
and terms that are required for understanding the software. 
And we’re confident that these projects provide the practice 
you need to be able to create sophisticated artwork by the end 
of the very first project.
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 8 Photo Gallery Web Page

o	 Automating Repetitive Tasks

o	 Building 
Frame 
Animations

o	 Slicing the 
Page 
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 7 House Painting

o	 Preparing the 
Workspace

o	 Filling Solid 
Areas

o	 Painting with 
Brushes

o	 Working with Patterns

o	 Painting Nature

o	 Publishing the Project
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 6 Advertising Samples

o	 Cleaning and Adjusting Images

o	 Working in Perspective

o	 Working with Lighting

o	 Working in Three 
Dimensions 
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 5 Catalog Cover

o	 Creating a Complex Selection

o	 Compositing 
Complex 
Selections

o	 Working with 
Spot Channels
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 4 Menu Image Correction

o	 Retouching Damaged 
Images

o	 Correcting Lighting 
Problems

o	 Correcting Color Problems

o	 Preparing Images for Print
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Getting Started
 prereQuisites

Th e entire Portfolio Series is based on the assumption that you have a basic understanding of how to use 
your computer. You should know how to use your mouse to point and click, as well as how to drag items 
around the screen. You should be able to resize and arrange windows on your desktop to maximize your 
available space. You should know how to access drop-down menus, and understand how check boxes 
and radio buttons work. It also doesn’t hurt to have a good understanding of how your operating system 
organizes fi les and folders, and how to navigate your way around them. If you’re familiar with these 
fundamental skills, then you know all that’s necessary to use the Portfolio Series. 

resource files

All of the fi les that you need to complete the projects in this book are on the provided Resource CD 
in the RF_Photoshop folder. Th is folder contains nine subfolders, one for each project in the book 
(including the Interface); you will be directed to the appropriate folder whenever you need to access a 
specifi c fi le. Files required for the related Portfolio Builder exercises are in the RF_Builders folder. 

Th e Resource CD also includes a WIP folder, which also contains (mostly empty) subfolders for each 
project in the book. Th is is where you will save your work as you complete the various projects. In some 
cases, the location of a fi le will be extremely important for later steps in a project to work properly; that’s 
why we’ve provided a specifi c set of folders with known fi le names. 

Before you begin working on the projects in this book, you should copy the entire WIP folder to your 
hard drive or some other recordable media such as a fl ash drive; when we tell you to save a fi le, you 
should save it to the appropriate folder on the drive where you put that WIP folder.

Atc fonts

 You must install the ATC fonts from the Resource CD to ensure that your exercises and projects will 
work as described in the book; these fonts are provided on the Resource CD in the ATC Fonts folder. 
Specifi c instructions for installing fonts are provided in the documentation that came with your com-
puter. You should replace older (pre-2004) ATC fonts with the ones on your Resource CD.

systeM reQuireMents

As software technology continues to mature, the diff erences in functionality from one platform to an-
other continue to diminish. Th e Portfolio Series was designed to work on both Macintosh or Windows 
computers; where diff erences exist from one platform to another, we include specifi c instructions relative 
to each platform. 

One issue that remains diff erent from Macintosh to Windows is the use of diff erent modifi er keys 
(Control, Shift, etc.) to accomplish the same task. When we present key commands, we always follow 
the same Macintosh/Windows format — Macintosh keys are listed fi rst, then a slash, followed by the 
Windows key command. 

xv

Windows
•  1.8GHz or faster processor
•  Microsoft® Windows® XP with Service Pack 2 or 

Windows Vista® with Service Pack 1
•  512 MB of RAM (1 GB recommended)
•  1 GB of available hard-disk space for installation
•  1,0241768 display with 16-bit video card
•  Some GPU-accelerated features require graphics support 

for Shader Model 3.0 and OpenGL 2.0
•  DVD-ROM drive
•  QuickTime 7.2 required for multimedia features

Macintosh
•  PowerPC® G5 or multicore Intel® processor
•  Mac OS X v10.4.11–10.5.4
•  512 MB of RAM (1 GB recommended)
•  2 GB of available hard-disk space for installation
•  1,0241768 display with 16-bit video card
•  Some GPU-accelerated features require graphics support 

for Shader Model 3.0 and OpenGL 2.0
•  DVD-ROM drive
•  QuickTime 7.2 required for multimedia features

Minimum System Requirements for Adobe Photoshop CS4:






